)esign Training

Exrto

FDOT Automated Quantities
Part 2
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Objectives

* Explore and learn how to use the tools in the Quantity Workflow to develop
Plan Summary Boxes and Summary of Quantity Sheets, get the data to
Designer Interface, and create the Summary of Pay Items Sheet.

* Review Plan Summary Box Requirements

Create Summary Boxes through Linked Data Manager
* Automated

* Non-Automated
Generate Reports in Quantity Manager to use to fill in Summary Box information
Get quantity information to Designer Interface

Access AASHTOWare Project Reporting to get Project Summary Reports for the Summary
of Pay Items

Create Summary of Pay Items Sheet
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* ALL quantities are to be documented by location on Plan Summary Boxes
for Roadway & Structures components.

* Plan Summary Boxes are to be located on the Summary of Quantities

sheets.
* Plan Set Location

* Roadway - keep in same order sequence behind the Typical Section sheets

* Structures - Directly behind the Summary of Pay Items in the General Bridge section (or
behind the Key Sheet if no Summary of Pay Items sheet)

* File Name
* Roadway - SUMQRD**
 Structures - B#SumofQuantities*
* Sheet Prefix
* Roadway - SQ-
¢ Structures — BQ#-

Each Bridge will have a separate Summary of Structural Quantities sheet (or

sheets). Number the Summary of Structural Quantities sheets BQ#-#. Example: if there
are general bridge pay items (mobilization MOT etc) the sheet will be the first summary of
structural quantities sheet and the sheet number will be BQ-1. The summary of quantities
for bridge one will follow; sheet number(s) BQl-1, BQl-2 etc., followed by bridge 2; sheet

number BQ2-1, BQ2-2 etc..
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FDOT

All other components (i.e. Signing & Pavement Markings, Signalization,
Lighting, etc.) are to use Tabulation of Quantities sheets.

* Drainage systems are to be documented on the Summary of Drainage
Structures sheets same as they have always been handled.

* Do NOT add pay item numbers.

* Incidental drainage items to a project can be documented on the Summary of
Miscellaneous Drainage Items.
* Intended for projects with Miscellaneous Drainage Items or on projects with minimal

drainage work, i.e. replacing broken inlet tops or moving structures to accommodate
added turn lanes, etc.

* Do NOT include items on this box that are included on the Summary of Drainage
Structures sheets.
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FDOT 'S'TANDARD S|

A listing of standard summary boxes is located in Chapter 8 of the BOE.
http://www.dot.state.fl.us/programmanagement/Estimates/BasisofEstimates/BOEManual/
Files/Chaptero8SummaryBoxes.pdf

Do NOT create non-standard boxes or modify current summary boxes with

Non-Standard columns or rows.

Formatting in MicroStation is controlled through Excel files.
* FDOT templates have already been formatted for use.

* Columns and rows may be adjusted or hidden in Excel and change is reflected in
MicroStation when link is updated.

* Columns may be deleted when not used. However do NOT delete the Construction
Remarks or “F” columns.

* When copying data into the template files, make sure to use the “Values Only” option
to paste.
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http://www.dot.state.fl.us/programmanagement/Estimates/BasisofEstimates/BOEManual/Files/Chapter08SummaryBoxes.pdf

Linked Data Manager (LDM)

* FDOT tool that uses Excel templates to generate Plan Summary Boxes.

* Creates a link between the Excel file and the MicroStation dgn file for
easy updates.

* Always make changes to spreadsheet, save and then right click on the
link in the list and choose Update Now.

Note: this is a ONE WAY process. Changes made in MicroStation cannot be updated to
Excel.

“ FDOT Linked Data Manager 1.01.10 — o

oo (g X @ B8

D Source Path Descoription

11578 | calculations™\Summary

Open Source

Fit

Lock Data

Delete Link
Delete Link and Graphics

Properties J
Add (Create Link) 720 ’6 - " \ s
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Linked Data Manager (LDM)

¢ Automating Plan Summary —
B O X e S |@ Create New from Template | ﬁ Create New from Quantities
. . Source Path Quantity Manager Summary Reports /
[ ]
When creating a link use t.he pesrpion [ |
Create New from Quantities GQuantty Marager Datsbase: | Aoadey\Z204555520 ’|
O tio n Force all text imported from database to be UPPER CASE
p : Report Description File Name ~
[} * ) Summary of Bamier Walls Summary_of_Bamier_Walls
S e I e Ct t h e Q M d ata b a S e ( ° m d b Summary of Curb and Traffic Separators Summary_of_Curb_and_Tr...
Summary of Ditch Pavement Summary_of_Ditch_Pavem...
° S e I e Ct t h e S U m m a ry tO b e Graphics Settings Summary of Driveways Summary_of_Driveways_E...
Summary of Edgedrain Summary_of _Edgedrain
C re a t e d (® FDOT  |Standan Summary of Erosion Control Summary_of _Erosion_Control
O Site Summary of Fencing Summary_of_Fencing
) 1 1 Summary of French Drain Summary_of _French_Drain...
S a Ve t h e fl I e to t h e Ca I C u I a tl O n S () Project Summary of Guardrail Summary_of_Guardrail_Ex...
1 1 Summary of Mailboxes Summary_of_Mailboxes
d I re Ct O ry Of t h e p rO] e Ct Summary of Miscellaneous Asphalt Summary_of_Misc_Asphalt
[] use
Summary of Permanent Crash Cushions Summary_of_Pemanent_C...
Summary of Railing Summary_of_Railing_Expa...
Summarny of Sidewalk Summary of Sidewalk W
oK | | Cancel |
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Linked Data Manager (LDM)

Automating Plan Summary Boxes

Set up the link settings and select OK to
place the sheets and links

| o |
T
poia o o0 Rewrwas el comcmor raur ca pa dw a0 mac | emad b e b cs | |
Link Infermation —————— —
— ] —
¥ ¥ s rwiecs ] 1
— ] —
| N YT S ST TR I
— ] —
Source File —— —
I e
&' Create New from Template % Create New from Quantities
Source Path | \calculations\Summary_of _Pavement xdsx ~| ||| =
Description
Quantity ] Wace Title Block
Report

Header Rows Cell Library [roadway.cel | celogfix
Table Array X Cell Name [shplan | c

Graphics Settings

‘ @® FDOT  |Standard ~ )

) Site

() Project

‘ [ Use Drawing Scale Update Graphics onJ#fe Open [ ] Lock Graphics [ ] Use Print Area '

0K Cancel




Linked Data Manager (LDM)

Automating Plan Summary Boxes

* Once placed, the plan sheet borders are not linked and can be moved/deleted
as needed. Summary boxes can also be moved. There will be a separate link
for each summary box placed.

* If a quantity changes and the boxes need to be updated, the same process
can be used. Overwrite the existing file in the Calculations folder and then
cancel the placement of the links. Update the existing links for the summary
boxes.

* Note: If there are any customizations in the Excel file (i.e. columns hidden or
widened) they will need to be redone in the newly created Excel file.
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Linked Data Manager (LDM)

Source Fle

I@ Create New from Template

I ﬁ Create New from Quantities

Source Path o | | P E | B
Description |
Select FDOT plate
omputation 5. mary Boxes ( ~
Text Motes
Word Document File Mame
gl:t; mss Summary_of_Bamier_Walls.. .
Sheets Summary_of_Beox_Culvers....
(e Tl Compitation Summany Boxes eparators Summary_of Curb_and_Tr...
Summary of Ditch Pavement Summary_of_Ditch_Pavem. ..
(® FDOT [ Summary of Driveways Summarny_of_Driveways xsx
O Site Summary of Earthwork Summary_of_Earthwork xdsx
Summary of Edgedrain Summary_of_Edgedrain xdsx
() Project Summary of Erosion Contral Summary_of _Erosion_Cont ...
Summary of Fencing Summary_of_Fencing xdsx

Summary of French Drain

Summary of General kems

Summary of Geotechnical kems
Summary of Guardrail

Summary of Litter Removal and Mowing
Summary of Lump Sum kems

Summary of Mailboxes
[ — oF Micrallznan o Aomhah

Summary_of_French_Drain...
Summary_of_General_ftem. ..

Summary_of_Geotech xdsx
Summary_of_Guardrail xdsx

Summary_of_Litter_Remov...
Summary_of _Lump_5Sum_k. .

Summary_of_Mailboxes xdsx
[ — oF Mior fonhah

* Creating Plan Summary
Boxes from Templates

* When creating a link, select
Create New From Template
for summary boxes that are
not included in the automated
list.

* Note: The templates are
available for ALL summary
boxes in the drop down for
designers who do not use
D&C Manager or Quantity
Manager.
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Linked Data Manager (LDM)

* Creating Plan Summary Boxes
from Templates

Save the Excel file to the
Calculations folder in the project
directory.

Once saved, the Link Information
dialog will come back up, select
the Box1 worksheet from the
dropdown.

Select the Graphic Settings.
Select desired link settings.

Click OK and click in the
MicroStation file to place the link
and graphics.

Link Information

Source Fle

@ Create New from Template ﬁ Create New from Quantities

Source Path | McalculationstSummary_of _Litter Removal_and_Mowing xdsx v | | E ||

Description | |
Excel Settings

Worksheet [BoxT v| Header Rows
Width/Height | || | Ofset})Y| || | [] Use Title Cell

Graphics Settings

@® FDOT  |Standard v|

y——

O Project i

[[] Use Drawing Scale IUpdate Graphics on File Open [ ] Lock Graphics [ ] Use Print Area

Cancel
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Linked Data Manager (LDM)

* Creating Plan Summary Boxes from Templates
* Right click on the link in the LDM tool box to get the option Open Source.
* Once open, make the necessary changes to the file and save.
* In MicroStation, right click on the link in LDM again and select Update Now.

“ FDOT Linked Data Manager 1.01.10 - *

SIEEG TS

Is] Source Path Description

11578 Mcalculations’Summary_of Litter Removal and. .

Fit
Lock Data

Delete Link
Delete Link and Graphics

Properties

Add (Create Link)

C:h\e\projectsS54,22049555201AQT .
* Note: Reports generated from QM will help to speed up this process. 2019_/!‘/4‘\
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Linked Data Manager (LDM)

* Creating Plan Summary Boxes from Templates

* Summary of Structures Quantities
* Place the Plan Sheet at a scale of 12
* Do not turn on the option to use the Drawing Scale

[] Use Drawing Scale Update Graphics on File Open [ ] Lock Graphics [ | Use Print Area

|DK||CaerEI|
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Quantity Manager (QM)

* Generating Reports

* In QM, set the Trnsport Grouping
setting to the appropriate
category (Roadway = 0200)

* Select the desired Pay Item in the
Pay Item Pane.

* Select Tools > Reports > Create
from the QM menu.

i Cluantity Manager - Ch\e\projects55022049555201 ACT roadway  EC50.mdb

Project Edit YWiew Insert Tools Help

O = M E Feports ¥ Create L | 0z0n —
Graphic Wiewer Define Styles , —
Fayitern Tree  Payitern Tamme CAEYOTY FAYTE T Trns*port .. | Chain [
‘4 root rootRoadwa.. [0110 1 1 |0200 CLCON
Ela Roadway Design rootiRoadwa... (0110 1 1 0z00 CLCON
Ela Quantity Features rootFoadwa.. (0110 1 1 0200 CLCOM
m Milling Existing Asph, rootiFoadees... 0110 1 1 0200 CLEON
-] Stabilization & Subbase
w1 Base
-] Asphaltic Concrete
-] Sidewalk
-] Turt
=3 Pavt Remaoval Clearing&Grubhing
B - 00110 1 1 Clearing & Grubhing
-l 0110 4 Remaoval of Existing Concr
-] Concrete & Accessories
#-[ ] Maintenance of Traffic <
— e - '
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Quantity Manager (QM)

* Generating Reports
* Onthe report menu, select the report for the Area CSV file.
* Typein a name for the output.
* Click Create. The file will open in Excel.

Create Report *
Active Trns*port Groupings: 0200

Report Style: | FDOT Form F00-080-01 A «~
Report Type: C5Y
Report File Mame: | 0110_1_1.c5v =Y
Starting Page Mumber: | 1
[ 1 Report Only Selected Quantities

Append Create Cancel

* This file can be used to copy and paste the information into the template file generated
through LDM.

* When pasting the information into the template, make sure to use the option for Values Only so

that the formatting doesn’t change.
20t6_|— — h
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Quantities - QM to DI - Workflow

1. Export the Project Header information (xml file) from DI
2. Import the project header info into QM Project Preferences
3. Export the quantities report from QM (xml file)

4. Import the quantities to the project in DI
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Quantities - QM to DI — Workflow

1. Export the Project Header information (xml file) from DI
* This can be done in 2 locations...
* Project List
* Project Details
* (Click Update in the Project column to get to the Project Details)

. Designer Interface vweb Tms*port Preconstruction
* On either screen, select Export Header. FDOT_Q”)

Logged in as: rd964db Webgate Reporting Home  Help

Project List =:( Project Details } 0000000000000 CADD FTP Site
= . Federal #: N/A Letting Date: District: 00 Spec Year: 13 County: 55 - LEON Proposal: T8888
*
Des'gner Inte rface Web TrnS port PreconStrUCtlon Class: 7-Class 7 Type: C - Construction  Urban/Rural: Work Type: X1-New  Work Mix:
Construction
s Logged in as: rd964db Webgate Reporting Home  Help
Categories
Project.. Project Number aecXML Pro... Description Letting D... = Unit Sy... Proposal Dist Delete Number Description Alternate. .. Bridge ID Update te.. | View

O 0100 Structures 991234 Update lte... | View .

Export Header _ ! . 0O | o200 Roadway Update | lte_. | View
Update 0000000000000 CADD office testing English TE8s88 0
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Quantities - QM to DI — Workflow

1.

Export the Project Header information (xml file) from DI

* Select the drop down option beside the Save option and choose Save As.

* Save the xml to the project discipline directory (i.e. Roadway).

Contact the Service Desk  Web Policies & Notices

Do you want to cpen or save 0000000000000.5ml (770 bytes) from fdotwpl.dot.state.flus?

Open

Save {

} Cancel

H10% v
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Quantities - QM to DI - Workflow

1.
2.

Export the Project Header information (xml file) from DI

Import the project header info into QM Project Preferences
* In QM, select Project > Properties.

* On Project Properties, select Project > Import aecXML
Infrastructure v33 Project

Project Properties >

Froject

Irmport aecxhL Infrastructure w33 Froject

General Informatian

* Select the downloaded file select Open.

(1] Cuantity Manager - C\e\projects554,22049355201ACT roadway'22049355201.mdb

Froject Edit Wiew Insert Tools Help

O Mew..
= Open...
Close

gs . 0200

Mew Trns*port Groupings..

Impart
Expor
hlerge Datahase

FProperies...

Preferences...

ChelprojectsSS422049555201 AQTwroadway 22049555201 . mdb
ChglprojectsSSN220495852 01 AQTIroadway\ECS0 . mdb

Exit
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Quantities - QM to DI - Workflow

1.
2.

Export the Project Header information (xml file) from DI
Import the project header info into QM Project Preferences
* The Project Properties dialog opens with a new tab for the Trns*port Groupings.

 Select the desired options and then click Import.

Project Properties
Praject

General Trns*por Groupings

Import Trns*port Groupings

0100 Structures

0200 Roadway

0300 Signing

HEIEIE

0400 Lighting
0500 Signalization

<]

Import || Cancel
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3.

Export the quantities report from QM (xml file)
* Inthe Payitem Table view of the Pay Item Pane, select all of the pay items desired to be exported.
* Make sure the Trns*port Grouping is set correctly.

Quantities - QM to DI — Workflow

i Cuantity Manager - C\&\projects554422049555201 ACT roadway' 22049555201 mdb
Froject Edit Wiew Insert Tools Help

O Mew.. IFER |IZIEIIIEI w
& Open..
Category Payitemn
Cloze
rootiRoadwwa... (0520 1 10
Mew Trns*port Groupings... rootFoadwa... 0520 110
Impnrt y rootiRoadwwa... (0520 1 10
—— = 10
Export ¥ Export ETE
Merge Database Define Styles |19
Properies... WDOT Trns*prt Farmat %
FPreferences... rootRoadwa... (0520 110
] i rootiRoadwa.. (0520 1 10
ChelprojectsSSNZ2049555201 AQTroadwayi22049555201 .mdb SotRoadms 10520 110
CAgiprojectsSSAHZ2049555201 AQTwoadwayiECS 0. mdb rootRoadwa... 0520 1 7
it rootiRoadwa... (0520 1 7
rootiRoadwa... (0520 1 7
4

2016 _|—_— h
)esig'n Training

Exrpo



Quantities - QM to DI — Workflow

2.

3. Export the quantities report from QM (xml file)
* On the Export dialog, select the Export Style, aecXML + Funding
* Toggle ON the Rename option and leave as the default “DesignEstimate”.
* Typein a name for the xml file generated.

 Click Export. Export X
Active Trns*port Groupings: 0200

Export Style: [laecxhL + Funding Lo

Fename Trns*pon Groupings As: | DesionEstimate
Document Type: aecxhL Infrastructure w33
Document File Mame: | 00000000000CGuantities xml ﬂ
[ ] Expart Only Selected Quantities

Export Cancel

¢ Click OK on the information dialog about Properties missing. This is normal. The file generated will
have all the necessary information.
* Click OK on the Export Complete information dialog. 2016/!\—/ \5
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Quantities - QM to DI — Workflow

3. Export the quantities report from QM (xml file)
* In MicroStation, open the XML Quantity Rounder tool.

Cleanup and QC

Quantities

a8 s b & B

Survey

I Standard | CellApps || Actions| Design Apps | Roadway Traffic Control Traffic Plans | vr | 2 | L[| £ | @]

QOOOOCOOO0OVO

Create Files

Set Gecgraphic Ceordinate System
Set Plot Scale of File

Turn Level Filters On

Turm Level Filters Off

Adhec Manager

Sheets >
Sheet Navigator (Label Sheets)

RfClip (Sheet Clipping)

Label Shapes with ID
Linked Data Manager (LDM)

[©

AAMSHTOWare Project Preconstruction (TRNS*port) |

‘ 9 | Quality Control »

* Click Process XML File and navigate to and select the file exported from QM.
* Click OK on the Created file dialog and then click Finished — Exit Application.

AECITEM.xml Dewnload
Web Gate Website
FDOT TRM S*Eurt

(

Quantity Rounder

* Located on the FDOT Plans Development task menu > Quantities
* OR -onthe FDOT Actions Menu under Trns*port

[= ¥ML Quantity Rounder 1,00.01
Thiz application iz used to round quantities exported from Cluantity
Manager before uploading them to TRNS*port.

The selected XML file will not be modified - a new XML file will be created
at the same file path as the original with *_rounded.xml|” appended to the

filename.

Process XML File

Finished - Exit Application

‘wwﬂxf/wh
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Quantities - QM to DI - Workflow

1. Export the Project Header information (xml file) from DI
2. Import the project header info into QM Project Preferences
3. Export the quantities report from QM (xml file)
4. Import the quantities to the projectin DI
* On either the Project List or Project Details view, click on Import.

FDOTi i Designer Interface vweb Tms*port Preconstruction

Project List == Project Details - 0000000000000 CADD FTP Site
Federal #: N/A Letting Date: District: 00 Spec Year: 13 County: 55 - LEON Proposal: T6558
Class: 7-Class 7 Type: C - Construction rban/Rural: Work Type: X1-New  Work Mix:

Construction
Categories

Delete Selected

a—
Export Header ' Import ' Add Category
N

Copy Selected Category (none)

Delete Number Description Alternate... Bridge ID Update Ite... View
O 0100 Structures 991234 Update Ite.. | View -
] 0200 Roadway Update e | View

* Click on Select Files... and then navigate to the file exported and then rounded from the project
directory. (It will have _Rounded appended to the file name.) ‘

* Once selected click on Upload file. 2076/!\—/
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Quantities - QM to DI - Workflow

1. Export the Project Header information (xml file) from DI

2. Import the project header info into QM Project Preferences
3. Export the quantities report from QM (xml file)

4. Import the quantities to the projectin DI

* The results will show up on the screen. Thisis ALL or nothing. ot oo o e
« Green - Load Successful e e siccesstu | Prostsuccesstuylosce

INSERT Project: 0000000000000 S
Project Item Category: 0200

ltem: 01104 2
INSERT Project: 0000000000000
Project Item Category: 0200

Item: 0425 5 1
INSERT Project: 0000000000000
Project Item Category: 0200

Item: 042551
UPDATE Project: 0000000000000
Project Item Category: 0200

Item: 0327 70 1

v
Page 1 of 3 L 10 v | items per page 1-10 of 29 items

* Red - Errors (nothing loaded)

Project: Invalid category number. Must be numeric (E16)
Category: DesignEstimate

[tem:
Quantity: 20'6 /'\_/.
?esig'n Training
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Summary of Pay Iltems — Workflow
* Access Webgate Reporting

* From DI

* From Webgate site

* Select Designers, Estimators, and Reviewers > Project Edit Report

Logged in as: rd964db

Project List > Project Details - 0000000000000

Designer Interface web Trns*port Preconstruction

Webgate Reporting  Home  Help

CADD FTP Site

* This report should be run first to identify any errors with the pay items loaded on the project.

q

FDOT

-

-

Construction Sitemanager

y Designers, Estimators, and
Reviewers

» Equal Opportunity
¥ General Reporis

b Item Average Unit Cost by
Item Number Report

Item Average Unit Cost by
Item Range Report

Contract Project Directory
Report

I Crosswalk Report
b Master Payltem List Report

Proposal Section and Line
MNumbers Report

b Summary of Pay Items
Report

» Landscape Reports

P Maintenance Sitemanager

Florida Department of Transportation Session Time remaining: 00:18:43

AASHTOWare Project Webgate Reporting Tere e [ Lo

Summary of Pay ltems

This report produces a summary of pay items and quantities for a selected project. If propesal exist the report will be of the proposal level,
if no propoesal the report will be of the proejct level. Either level, project or proposal, may be used for phase reviews; the proposal
summary must be used for final plans. |dentifies the participating and non-participating quantity for each pay item. Use the button "Auto-
Generate Proposal Sections” to assign proposal section numbers and proposal item line numbers if some items are not ordered
correctly in report or XML file

Click to view video for the CADD Workflow for Quantities with Designer Interface.

Mote: Scroll to the bottom of the table of contents for how to create the Summary of Pay ltems Sheets.

Select/Enter Parameter Information: Required fields marked with asterisk(*)

Select Project: |UUUDGUOUI](IDI]U V\ | Auto-Generate Proposal Sections

O Report File
® CADD File

Report Type:

2016 | —
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Summary of Pay Iltems — Workflow
* Access Webgate Reporting

* From DI

* From Webgate site

* Select General Reports > Summary of Pay Items Report

»
»

P Construction Sitemanager
» Designers, Estimators, and

» Equal Opportunity
( ¥ General Reports

FDOT

Reviewers

Item Average Unit Cost by
Item Mumber Report

Item Average Unit Cost by
Itern Range Report

Contract Project Directory
Report

I Crosswalk Report

3

I Master Payltem List Report
b Proposal Section and Line

MNumbers Report
Report
Landscape Reports
e Sit

Florida Department of Transportation Session Time remaining: 00:18:43

AASHTOWare Project Webgate Reporting Denise Broom [ Heip| [ Logout

Summary of Pay ltems

Designer Interface web Trns*port Preconstruction

Logged in as: rd964db Webgate Reporting Home  Help

Project List > Project Details - 0000000000000

This report produces a summary of pay items and quantities for a selected project. If proposal exist the report will be of the proposal level,
if no proposal the report will be of the proejct level. Either level, project or proposal, may be used for phase reviews; the proposal
summary must be used for final plans. |dentifies the participating and non-participating quantity for each pay item. Use the button "Auto-
Generate Proposal Sections” to assign proposal section numbers and proposal item line numbers if some items are not ordered
correctly in report or XML file.

Click to view video for the CADD Workflow for Quantities with Designer Interface.

MNote: Scroll to the bottom of the table of contents for how to create the Summary of Pay ltems Sheets.

Select/Enter Parameter Information: Required fields marked with asterisk(*)

Select Project: |UDUDOUDUDOODU V| | Auto-Generate Proposal Sections

 Report File
® CADD File

Report Type:

CADD FTP Site

2016 _|——
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Summary of Pay Iltems — Workflow

S e I ectt h e P rOj ect FD Oﬁ Florida Department of Transportation Session Time remaining: 00:18:43
S e I e Ct R e p 0] rt Ty p e: C A D D Fi l e - AASHTOWare Project Webgate Reporting Denise Broom | Help | Logout

Summary of Pay ltems

} Construction Sitemanager

° . R B This report produces a summary of pay items and quantities for a selected project. If proposal exist the report will be of the proposal level,
C I l C k S u b m I t 3 m!‘-‘“"m Estimators; and if no proposal the report will be of the proejct level. Either level, project or proposal, may be used for phase reviews; the proposal
1ewers summary must be used for final plans. ldentifies the participating and non-participating quantity for each pay item. Use the button "Auto-

¥ Equal Opportunity Generate Proposal Sections” to assign proposal section numbers and proposal item line numbers if some items are not ordered
¥ General Reports correctly in report or XML file

S e I e Ct t h e S a V e AS O p t i O n 3 {::m ﬁ:ﬁ:‘?}g‘: ;Jg;tortCost L Click to view video for the CADD Workflow for Quantities with Designer Interface.

, Note: Scroll to the bottom of the table of contents for how to create the Summary of Pay ltems Sheets.
b Item Average Unit Cost by
Item Range Report

Y R e n a m e t h e fi I e if t h e Proj e Ct H e a d e r B %Eiﬁd Project Directory Select/Enter Parameter Information: Required fields marked with asterisk(*)

I Crosswalk Report

file is named the same as the default. | + vecroren o

b Proposal Section and Line
Mumbers Report

Note: The Auto-Generate Proposal | r&om | s

} Landscape Reports

Sections is now available for S N

. RepurlType:
Designers to run.

* If a proposal has been generated for a
project, run this report before creating
the Summary of Pay Items if pay items
have been added or modified.

Do you want to cpen or save 0000000000000.20ml from fdotwpl.dot.state.flus? . , \—/
Open Save l - Cancel S _/,‘ ——
- ?es:gn Training




Summary of Pay Iltems — Workflow

* In MicroStation, select the FDOT Trnsport tool

Cleanup and QC

Quantities

e/ EHE

Survey

[ standard | CellApps [ Actions | Design Apps | Roadway Traffic Centrol Traffic Plans | v7 | &7 | Tl (¢ | [H [ @]

B FDOT TRNS*port 2.00.20

— >

Input File: |C:\e\projectsSS4\22043555201AQ Troadway" T8888xml | | Browse.. |

County: |LEON

~|

Financial Number:  000000-0-00-00

|

Label Sheet

Road Number: l:l

Line 1: |SUMMARY OF PAY ITEMS |

Sheet Title:
Line 2: |

Sheet Mumber Preﬁx:|

b | Mumber: I:I

| Load Summary of Pay tems ‘

Create Files

Set Geographic Coordinate System
Set Plot Scale of File

Turn Level Filters On

Turn Level Filters Off

Adhoc Manager

Sheets

Sheet Mavigator (Label Sheets)
RfClip (Sheet Clipping)

Label Shapes with ID
Linked Data Manager (LDM)

QPROO0ROO00OVO

AASHTOWare Project Preconstruction (TRNS*port) |

OI Quality Control

4

AECITEM.xml Download
Web Gate Website

FDOT TRNS*port )|

I Quantity Rounder
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Summary of Pay Iltems — Workflow

¢ Select the Browse button and navigate to the save Summary of Pay
ltems report xml file.

* County and Financial Number are pulled in from the XML file.

¢ Lab6| Sheet iS toggled on by defaUlt. B FDOT TRNS*port 3.00.20 - X
‘ Optional Input File: |C:\e'projects 5541220495520 1AQ T\ roadway' T8888xml || Browse. |
* Click Load Summary of Pay Items N — 4
Financial Number: |[H]]]]]—D{HHH] V|
[] Label Sheet
HﬂadNumber:l:l
_ Line 1: [SUMMARY OF PAY ITEMS |
Sheet Title: Ling 2- | |
SheetNumberPreﬁx:| || v| Number:

| Load Summary of Pay ltems |
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Questions???
Thank-you for joining today’s session.
Need some HELP? Contact me...
(850) 414-4751
E-mail: Denise.Broom(@dot.state.fl.us

OR: ecso.support(@dot.state.fl.us
http://www.dot.state.fl.us/ecso

FDOT CADD Support Forum On-line
http://communities.bentley.com/communities/user communities/fdot

cadd support/default.aspx 2016/,\_/.!
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